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Goals 

In this lesson, you will learn:  



• why grid-based analysis is fast  
• how cell size determines the resolution of grid-based data  
• how ArcView Spatial Analyst handles projections  
• how to set a projection  
• how to georeference and transform grids  

TOPIC 1: Registration and resolution 
 

Registration and resolution are two important factors you need to consider before performing 
spatial analysis. For any database to be useful for spatial analysis, all its parts must be registered 
to a common coordinate system. A coordinate system is composed of a spheroid (a mathematical 
description of the Earth's shape) and a map projection (a mathematical conversion from spherical 
to planar coordinates). Registering all layers to a common coordinate system ensures data 
integrity during spatial joins and overlay.  

Resolution refers to how accurately the location and shape of map features can be depicted. In 
ArcView Spatial Analyst, cell size determines resolution. Cell size is chosen based on the size of 
the smallest feature that needs to be represented.  

Scale also affects resolution. In a larger-scale map, the resolution of features more closely 
matches real-world features because the extent of reduction from ground to map is less. As map 
scale decreases, the map resolution diminishes because features must be smoothed and 
simplified, or not shown at all 

Concept 
 
Grid-based coincidence analysis 
 

The most common type of grids in GIS are those that represent some phenomenon of the 
landscape (geology, soils, populated places, etc.) These grids of spatial data are not useful 
unless they are registered (aligned) to one another or to a common coordinate system. 
Otherwise, it is not possible to perform such basic operations as overlaying or merging.  

In its simplest form, cells in grids will stack neatly on top of each other when overlayed. The grids 
will share a common coordinate system, origin, and cell size. In other words, cells coincide with 
each other.  

Grid based coincidence analysis is fast because location is intrinsic to the data model. Unlike 
vector systems, which must mathematically compute the intersection of the input data, grid-based 
systems simply look up the same row and column positions in the input grids (tables). 



 
Grid-based analysis is fast because cells line up. 

Grid cells do not necessarily need to line up between layers to perform analysis though. Nor do 
the grids have to share the same resolution. As long as the grids share the same coordinate 
system, analysis can be performed. In these cases, data is simply resampled in the output grid 
 
Concept 
 
Resolution and cell size 
 

Grid themes represent geographic features by using cells and cell size is considered to be the 
resolution of the grid theme.  

An important characteristic of grids is that they always generalize spatial data to the nearest cell 
boundary. When generalization increases, error increases and precision decreases. Small cell 
sizes offer higher resolution (less generalization) and large cell sizes offer lower resolution (more 
generalization).  

Using a smaller cell size means that more cells are used to represent each feature. The physical 
storage size for a grid data set increases when more cells are needed. Cutting the cell size in half 
could increase the storage requirements by four times. The more cells that have to be evaluated, 
the more time it will take.  

Using a larger cell size require less storage space and allow for analysis operations to be 
performed faster. However, if the cell size is too large, the data may not be adequately 
represented.  

The data resolution that is required for the most detailed analysis determines the cell size. Cell 
sizes vary from study to study and grid theme to grid theme. Using a smaller cell size does not 
necessarily guarantee better accuracy. A smaller output cell size will not produce data more 
accurate than the inputs. The output grid should be the same cell size (or larger) than its inputs.  



Before choosing a cell size, consider the following factors:  

• Resolution of input data  
• Resulting database size and disk capacity  
• Desired response time (processing speeds)  
• The application and analysis to be performed  

 

 
This view contains vector and raster representations 
of a river. The smaller the cell size, the more 
accurate the rivers can be represented. 

Exercise 
 
Examine how cell size affects analysis 
 
The objective of this exercise is to learn about the 
relationship between cell size and resolution. You will 
compare a grid theme of a river network at two different 
resolutions and examine cell size properties at various 
scales. 

  

  
 
If you have not downloaded the 
exercise data for this module, you 
should download the data now. 

     
 

Step 1  
 
Start ArcView 

  

Start ArcView and load the Spatial Analyst Extension.  

Note: If you are running ArcView GIS 3.1, you see a Welcome to ArcView GIS dialog. 
Click Cancel to close this. 

If ArcView is already running, close any open projects. 

  

 
Step 2  

 
Open the project   

  From the File menu, choose Open Project. Navigate to the dbasesa\lesson1   



directory and open the project l1_ex01.apr. 

Note: If you are running ArcView GIS 3.1, you see an Update l1_ex01.apr message 
box. Click No to dismiss this box. 

When the project opens, you see a view containing feature and grid themes of a river 
network. 

The Rivers.shp line theme is turned on and the scale is set to about 1:90,000. The 
other two themes, River50 and River300, are grid themes that represent the same 
river features. They are turned off. 

 
 

Step 3  
 
Compare cell size and resolution  

  

Cell size and resolution are two important factors when creating, storing, and 
analyzing grid data sets. The smaller the cell size, the more accurately represented 
the data can be. In this step, you will examine two themes, each representing the 
same river feature, but stored using different cell sizes. 

The two grid themes in the view are River50 and River300. River50 uses a cell size of 
50 to represent the rivers and River300 uses a cell size of 300 to represent the same 
rivers. You will display and compare the different cell sizes. 

Zoom in on the Rivers view by typing 5000 (1:5000) in the scale input box on the 
toolbar. Press Enter.  

The view zooms to a river intersection.  

Turn on the River50 theme and make it active. 

Notice how the cells are used to represent the intersection of the river features.  

From the Theme menu, choose Properties to open the the Theme Properties dialog. 

Notice that the cell size is 50 and there are 631 rows and 609 columns.  

Click Cancel to close the Theme Properties dialog. Now turn on the River300 theme.  

Notice how the larger cells are used to represent the same river features. The smaller 
cells have a higher resolution and more closely represent the river.  

Make the River300 theme active and from the Theme menu, choose Properties. 

Notice that the cell size is 300 and there are 105 rows and 102 columns. 

Click Cancel to close the Theme Properties dialog. 

Zoom back out to 1:90,000 and turn off Rivers.shp and River50. (To do this, you can 

use the Zoom to Previous Extent button or type 90000 (1:90000) in the scale 

  



input box.) 

Notice that the larger the cell size, the more distortion, and the lower the resolution. 
Some of the river features in River300 appear braided with the larger cell size. 

At the scale 1:90,000 River50 represents the rivers best. 

Now zoom out to 1:300,000. 

Notice that River300 represents the rivers best. Cells from River50 can be seen, but 
they are patchy at this smaller scale.  

Zoom back to 1:90,000. 

At some display scales, River50 may be best or more appropriate and at other scales 
River300 is more appropriate. Several factors may influence your cell size decisions, 
including analysis, display, and storage of the raster data. In this example, the display 
scale is important. 

 
 

Step 4  
 
Close the project  

  Close the project without saving any changes. You have completed this exercise  
 
 
Projections 
 

Today, everyone agrees that the Earth is a curved surface. The Earth appears to be a sphere but 
in fact it is slightly flattened at the poles compared to the equator, so the Earth is what is called a 
spheroid or ellipsoid in shape.  

To be presented on a map, the Earth has to be depicted as being flat. Because the Earth is a 
spheroid, the spherical coordinate system has to be modified somewhat. A mathematical 
conversion must be used to represent the Earth's three-dimensional features on a flat surface. 
This transformation is commonly referred to as a map projection. Map projections ensure a 
known relationship between locations on a map and their true locations on the Earth. 

 
Map projections transform the three-dimesional 
surface of the Earth from geographic coordinates to a 
flat surface in Cartesian coordinates. [Click to 



enlarge] 
Location on the Earth's surface is specified in geographic coordinates of latitude and longitude, 
which are usually assigned the mathematical symbols for latitude and for longitude.  

Flat maps in a GIS use projected coordinates to map the Earth's surface. Projected coordinates, 
also called Cartesian or planar coordinates, consist of an x (Easting) coordinate and a y 
(Northing) coordinate. X measures distance to the east and y measures distance to the north, 
relative to the location of the origin of the coordinate system.  

Map projection is a mathematical process in which, for all the coordinate points of each 
geographic feature, the latitude and longitude locations on the Earth's surface are transformed to 
x,y locations on a map.  

Understanding the uses of map projections and latitude-longitude reference points is important as 
you begin to use ArcView Spatial Analyst to develop your database. For the moment, note the 
following:  

• Any representation of the Earth's surface in two dimensions always distorts one or more 
of the attributes of shape, distance, area, and direction.  

• Different projections produce different distortions.  
• The characteristics of each projection make them useful for some applications and not 

useful for others. Matching a map projection to your needs is an important task.  

 

 
All projections distort at least one of the attributes of shape, area, 
distance, and direction. 

ArcView provides lists of standard and custom projections. From these lists, you can access more 
detailed information about any of the projections that ArcView supports. For more information, 
search for these help topics: Map projections, Setting the map projection.  

Although you don't need a complete understanding of map projections to ensure the coordinate 
values in your database are measured in a real-world coordinate system, it's an important issue 
when dealing with large amounts of map data whose projection sources may vary. In this topic, 
you will learn how you can work with feature and grid themes in a common coordinate system. 

Concept 
 
Geographic coordinates 

The most familiar locational reference system is the spherical coordinate system measured in 
latitude and longitude. This system can be used to identify the locations of points anywhere on 



the Earth's surface. Because of its ability to reference locations, the spherical coordinate system 
is usually referred as the geographic coordinate system or the global reference system.  

If we treat the Earth as a sphere, a graticule (a reference grid of latitude and longitude lines) can 
be superimposed on the Earth's surface to geographically reference various locations. Longitude 
and latitude are angles measured from the Earth's center to a point on the Earth's surface. 
Longitude is measured east and west, while latitude is measured north and south. Longitude 
lines, also called meridians, stretch between the north and south poles. Latitude lines, also called 
parallels, encircle the globe with parallel rings. 

 
Diagram of latitude and longitude. 

Latitude and longitude are traditionally measured in degrees, minutes, and seconds (DMS). 
Longitude values range from 0° at the Prime Meridian (the meridian that passes through 
Greenwich, England) to 180° when traveling east and from 0° to –180° when traveling west from 
the Prime Meridian. For example, Australia, which is south of the equator and east of Greenwich, 
has positive longitude and negative latitudes.  

All locations on Earth have a latitude and longitude. For example, the location of New Orleans, 
Louisiana, is approximately ( , ) = (30° N, 90° W). More precise locations are presented in 
degrees (°), minutes ('), and seconds ("), where 1° = 60' and 1' = 60".  

Locations can also be specified in decimal degrees, calculated as:  

decimal degrees = degrees + minutes/60 + seconds/3600  

Latitude-longitude is a geographic reference system, not a two-dimensional (planar) coordinate 
system. In the figure below, notice how meridians converge at the poles but separate or diverge 
as they get closer to the equator. The length of one degree of longitude varies depending upon 
the latitude at which its measured. For example, one degree of longitude at the equator is 111 
kilometers (69 miles) in length, but the length of one degree of longitude converges to zero at the 
poles.  

Because degrees aren't associated with a standard length, they can't be used as an accurate 
measure of distance or area. Only along the equator does the distance represented by one 
degree of longitude approximate the distance represented by one degree of latitude. And, 
because this reference system measures angles from the center of the Earth, rather than 



distances on the Earth's surface, it's not a planar coordinate system. Similarly, because the global 
coordinate system is used for the curved surface of the Earth, this system cannot be called a map 
projection 

Concept 
 
Planar coordinate system 
 

Because it is difficult to make measurements in spherical coordinates, geographic data is 
projected into planar coordinate systems (often called Cartesian coordinates systems). On a flat 
surface, locations are identified by x,y coordinates on a grid, with the origin at the center of the 
grid. Each position has two values that reference it to that central location, one specifying its 
horizontal position and the other its vertical position. These two values are called the x coordinate 
and the y coordinate.  

On a gridded network, constructed of equally spaced horizontal and vertical lines, the horizontal 
line in the center is called the x-axis and the central vertical line is called the y-axis. Equal 
spacing represents units consistent across the full range of x and y. Horizontal lines above the 
origin and vertical lines to the right of the origin are assigned positive values; those below or to 
the left are negative. The four quadrants represent the four possible combinations of positive and 
negative x and y coordinates.  

 
Diagram of a planar coordinate system. The four quadrants represent the 
four possible combinations of positive and negative x and y coordinates. 

Planar coordinate systems have several properties that make them useful for representing real-
world coordinates:  

• There are two dimensions: x measures distance in a horizontal direction, and y measures 
distance in a vertical direction.  

• Measures of length, angle, and area are constant across the two dimensions.  



• Various mathematical formulas exist to project the Earth's spherical surface onto a flat, 
two-dimensional surface 

Concept 
 
Projection issues 
 

There are several important projection issues to consider when displaying feature and grid 
themes together in a view.  

When a grid theme is displayed in a view, it is assumed to be in a projection. Grid themes are not 
projected in a view, even if a view's projection is set, because it takes a long time to project raster 
data.  

When a projection is set on the fly for a feature theme, it is assumed that the map units of the 
theme are in decimal degrees. Only the display of the theme is projected. The coordinates stored 
with the theme's data sources are not changed or edited to the new projection values.  

Because grids are in the ARC GRID format, they could be in any map projection supported by 
ArcInfo. ArcInfo can project grids from one map projection to another (ArcView GIS cannot). A 
grid's prj.adf projection file is created during the ArcInfo projection process.  

If present, the projection file is important because it contains the grid's projection parameters. 
This will help you if you need to set the projection for a view. The prj.adf file is an ASCII file that 
you can view with any text editor such as Notepad or Wordpad. Be careful not to edit the prj.adf 
file.  

Projection files may be found in ArcInfo coverages and grids. ArcView shapefiles, however, do 
not have anything like a projection file. ArcView always assumes shapefiles are in decimal 
degrees. If a shapefile is in a different coordinate system, there is no way to determine this other 
than through your own knowledge of the dataset's history. 

Concept 
 
Setting a projection 
 

How do you determine the appropriate projection to set for a view? Answer: Examine the 
coordinate systems of your raster and vector themes source data to determine the correct 
projection parameters to use.  

If your raster and vector data are stored in the same coordinate system, you do not need to set a 
projection for the view. When all themes are in the same coordinate system, valid analysis can be 
performed.  

If your raster and vector data are stored in different coordinate systems, you will need to project 
the view. If a view is going to be projected, the map units for the vector data (feature themes) are 
assumed to be in decimal degrees. The vector data is projected on the fly and is displayed in the 
new coordinate system. The view's projection, however, does not affect grid and image themes. It 
is assumed they are already in the projection.  



The projection for the view must be set to the same projection as the grid and image themes. Any 
vector data created during analysis (e.g., contour lines) will have map units in decimal degrees. 
Any raster data created during analysis will be created with coordinates in the projected space.  

The table below will help you determine whether you need to set a projection for the view.  

Feature theme map 
units 

Grid theme map 
units 

View's 
projection Analysis 

DD DD None Poor with 
distance 

DD Projection X Projection X Yes 
Projection X Projection X None Yes 
Projection X Projection Y Problem No 

Analysis that involves spatial measurement (distance to wells, areas of a cropland, etc.) must 
always consider the properties of the projection. All projections distort distance, direction, size, 
and shape. It is important to choose a projection that will support the type of analysis you are 
going to perform.  

It is common for grids derived from scanned images such as aerial photos to have no projection. 
In these cases, the x,y origin is usually assigned an arbitrary value of 0,0 with a cell size of 1.  

The Projection Utility extension comes with ArcView GIS 3.2 and higher (in previous versions of 
ArcView, this was a sample extension called The Projector!). This extension allows you to change 
the data source of a feature theme from any supported projection to any other supported 
projection in ArcView. Therefore, in a situation like row four in the table above, you would be able 
to project your feature theme to the projection of your grid theme. 

Example 
 
Working with projections 
 

Jennifer is a state planner tasked with mapping predicted noise levels from a proposed freeway. 
To minimize the impact of noise from traffic, portions of the freeway will be constructed below 
street level in areas where the noise level would disrupt residential areas if built at or above street 
level.  

Jennifer already has feature themes of zoning, streets, and the proposed freeway. She just 
obtained an elevation theme derived from a digital elevation model (DEM) for her study area. 
Before she begins her modeling, she wants to display the themes together in ArcView. Her 
feature themes are in decimal degrees but she is not sure what projection the digital elevation 
model is in.  

 



 
The view on top contains Jennifer's three feature 
themes. The view is unprojected and the coordinates 
are in decimal degrees. Behind this is her grid theme 
of elevation. This data is stored in UTM meters, Zone 
11. [Click to enlarge] 

Jennifer first checks to see if the elevation theme has a prj.adf file. If present, this file will tell her 
the projection of the grid theme. If not, she would have to contact the source of the data to 
determine the projection. The prj.adf file is present so she opens the file in Notepad. The 
projection file indicates the elevation theme is in the UTM projection, Zone 11 and uses units of 
meters.  

Jennifer begins by selecting Add Theme from the View menu and adds her feature themes and 
grid themes to the same view. At this point, all four themes cannot be viewed together because 
they are not in the same projection.  

Next, Jennifer will set a projection. She selects Properties from the View menu. In the View 
Properties dialog she chooses meters as the map units. 

 
ArcView uses the Map Units setting to determine the 
correct scale of the view. If no projection is set, Map 
Units should be set to the units of the base data. If a 
projection is set, Map Units are the units of the 
projected space. [Click to enlarge] 



 

 

Then she chooses the Projection button to set the projection of the view. In the Projection 
Properties dialog she sets the projection to UTM Zone 11. Because grid themes are already 
assumed to be in a projection, only the feature themes will be effected by setting the projection. 

 
Jennifer sets the projection to UTM Zone 11. [Click to 
enlarge] 

She exits each of the dialogs by clicking OK.  

The feature themes and grid theme are now all in a common coordinate system and displayed 
together. The feature themes have been projected on the fly to match the projection of the grid 
theme. 

 
Notice that the coordinates in the upper right are 
now in UTM. 

Exercise 
 
Examine projections and coordinate systems 
 
The objective of this exercise is to learn how to work with 
projections within ArcView Spatial Analyst. You will set a   



projection for a view in order to display a grid theme in the 
UTM projection with a feature theme in decimal degrees. 

  
 
If you have not downloaded the 
exercise data for this module, you 
should download the data now. 

     
 

Step 1  
 
Start ArcView 

  

Start ArcView and load the Spatial Analyst Extension.  

Note: If you are running ArcView GIS 3.1, you see a Welcome to ArcView GIS dialog. 
Click Cancel to close this dialog. 

If ArcView is already running, close any open projects. 

  

 
Step 2  

 
Open the project   

  

From the File menu, choose Open Project. Navigate to the dbasesa\lesson1 
directory and open the project l1_ex02.apr. 

Note: If you are running ArcView GIS 3.1, you see an Update l1_ex02.apr message 
box. Click No to dismiss this box. 

When the project opens, you see the project window containing a Lakes view. 
Double-click on the Lakes view to open it.  

The view contains a feature theme of lakes and a grid theme of elevation. Only the 
Lakes theme is visible as the projection for the view is not set. 

  

 
Step 3  

 
Examine the coordinates for a feature theme  

  

For a view to be projected, it is assumed that its feature themes are in decimal 
degrees. 

Drag your mouse within the Lakes view and examine the coordinates in the upper 
right corner of the ArcView toolbar. Notice that the coordinates appear to be in 
decimal degrees (actually within Southern California). 

 

  

 
Step 4  

 
Examine the coordinates for a grid theme  

  

Make the Elevation theme active. Click the Zoom to Active Theme button . 

The elevation theme should appear. 

Drag your mouse within the Elevation view and examine the coordinates in the upper 
right corner of the ArcView toolbar. Examine the range of coordinate values.  

In this case, the coordinates are in the UTM projection, Zone 11 with units of meters. 

  



ArcView Spatial Analyst assumes that grid themes are already in a projection and 
cannot project them on the fly as it would be too time-consuming to do so. 

 
 

Step 5  
 
Project a view  

  

When you know the grid theme's projection and map units and have verified that the 
feature theme's are in decimal degrees, you are ready to set the projection for the 
view. 

From the View menu, choose Properties. 

In the View Properties dialog, set the map units to meters. 

Next, click the Projection button.  

The Projection Properties dialog opens. 

Choose UTM for the Category. (If you're using ArcView GIS 3.1, choose UTM 1983.) 
Choose Zone 11 for the Zone. 

Click OK to close the Projection Properties dialog. Click OK again to close the View 
Properties dialog. 

Click the Zoom to Full Extent button . 

The two themes are now visible together. The feature theme was projected on the fly 
to match the grid theme in the UTM projection. The feature theme is projected for 
display only. Notice that the grid themes coordinates have not changed at all. 

 

  

 
Step 6  

 
Close the project  

  Close the project without saving any changes. You have completed this exercise.  
 
TOPIC 2: Georeferencing 
 

In this topic, you will learn how to georeference a grid. A georeferenced grid is one in which the 
cell coordinate values are in a real-world coordinate system. You can combine grids in a map 
algebra expression only if they have been registered or georeferenced.  

Algebraic manipulation of multiple grids is possible because each cell in one grid can be 
associated with a cell or group of cells representing the same real-world area in another grid. 
Without a common coordinate system, valid associations are impossible. This means that each 
location on the ground must be represented by the same x,y cell address on all the different input 
grids.  

The coordinate values of the output grid cells change when you georeference a grid, because the 
x,y axes are shifted, rescaled, and rotated. The process of converting data from one coordinate 
system to another is called coordinate transformation. ArcView Spatial Analyst supports the type 



of coordinate transformation known as warping. Links are used to assign real-world locations to 
locations on a non-georeferenced grid. Statistics can be generated to help determine the 
goodness of fit for a transformation.  

The warping functions available within ArcView Spatial Analyst are available in the form of the 
Avenue Warp request and the Warp Environment extension.  

The warping functions create new grids with transformed geometry. The cells in the new grids 
may be rescaled, shifted, or rotated with respect to the location of the cells in the output grid. 
ArcView Spatial Analyst uses a form of resampling to assign values to the new cell locations.  

Transformation is a process that you might perform on a scanned map to shift or rotate it to 
match up with other themes. If you scan a map (e.g., a USGS 7.5 minute quad sheet) sideways, 
you may rotate it 90 degrees. 

Concept 
 
Georeferenced grids 
 

Georeferencing is the process of establishing the relationship between a grid coordinate system 
(rows and columns), called grid space, and a map coordinate system (x,y), called map space. To 
georeference, a grid needs to be registered to a shapefile, coverage, or set of coordinates that 
are in map space.  

If a grid has been georeferenced, its x,y coordinates are based on a projection. Analysis that 
involves spatial measurement (distance to wells, areas of cropland, etc.) must consider the 
properties of the grid's projection (true distance, true area, true direction, and true shape). 

 
Registered grid and feature themes. Both themes match real-world locations. 

Without registration, valid associations between grids in different coordinate systems are not 
possible.  



In ArcView Spatial Analyst, either the Avenue Warp request or the sample Warp Environment 
extension can be used to register a non-georeferenced grid to a real-world coordinate system. 

Concept 
 
Non-georeferenced grids 
 

A non-georeferenced grid may be a converted image that has its origin at (0, 0). A grid that is not 
referenced to any real-world location will not match up with your other themes that are in real-
world coordinate systems. The georeferencing process helps you assign real-world coordinates 
and match your grid with other data. 

 
In a non-georeferenced grid, cells do not match real-
world locations. 

Concept 
 
Defining "from" and "to" links 
 

There is really only one way to register an unregistered grid to a projection: find the coordinates 
of a point on the grid in the grid's current units (the from-point), and the coordinates of the point in 
the desired projection's units (the to-point). Each from- and to-point pair is a link.  

A link simply stores the unregistered coordinates of a location on your grid and the corresponding 
coordinates for that location in the desired map projection. That is, it stores a "from" x,y 
coordinate and a "to" x,y coordinate.  

 



Link lines are used by the warp request to link 
known locations from the non-georeferenced grid to 
the theme in real-world locations. [Click to enlarge] 

Links are used in the Avenue Warp request and the Warp Environment extension to assign real-
world locations to locations on a non-georeferenced grid.  

By defining enough link lines, the Warp request can calculate the transformation coefficients 
(scale, shift, and rotate values for a first-order polynomial) needed to mathematically fit your grid 
to the desired projection.  

The minimum number of links necessary for a given order of polynomial when you use the Warp 
request or the Warp Environment extension can be determined by the following formula:  

n = (p + 1) * (p + 2) / 2  

where n is the minimum number of links required for a transformation of polynomial order p. For 
example, a first-order polynomial requires three links, and a second-order polynomial requires six. 
It is strongly suggested to use more links than the minimum required number.  

Normally, links are created in the direction of the from theme to the to theme. This is the normal 
Forward transformation. If you prefer, you may create links in the direction of the to theme to the 
from theme. This is the Backward transformation. It doesn't matter which convention you use, but 
be careful to not mix the conventions. 

Concept 
 
Calculating polynomial fit prior to Warp 
 

As you learned in the discussion on Warp, you should try to select the lowest polynomial order 
that produces an acceptable RMS error. You can calculate RMS error by either using the 
CalcPolynomialFit request before using the Warp request or Calculate Fit from the Warp menu 
while using the Warp environment extension.  

The Calculate Fit menu choice is enabled when the From View is active, a grid theme is the 
active theme, a Link Table is set, and all links have both "from" link and "to" link coordinates.  

The CalcPolynomialFit request has the following syntax:  

Grid.CalcPolynomialFit (aLinkList, anOrder, aCoefFN, anErrorFN, 
backTransform)  

Both options allow you to attain polynomial fit statistics on the active grid theme with the links 
found in the current link table without actually performing the warp of the grid. This is used to test 
the goodness of fit for a polynomial transformation based on the current links. The result is a 
message box with total RMS error values and Chi-Square values for both the X and Y directions.  

Errors are recorded in To coordinate units in a forward transformation and From coordinate units 
in a backward transformation. For example, if you are registering to the UTM projection and the 
To coordinates are in meters, then the errors are in meters.  

Also, two tables are produced: the Coefficients Table and the Errors Table.  



The Coefficients Table has the following Fields: Coef #, X Coef, and Y Coef. There will be a 
record for each coefficient in the transformation. 

 
The Coefficients table. 

The Errors Table has the following Fields: Link-id, Input X, Input Y, Output X, Output Y, X Error, 
and Y Error. There will be a record for each link 

Concept 
 
Interpreting the RMS error 
 

Root mean square (RMS) error is based on the best fit equation that attempts to relate the input 
and output coordinate values in a single mathematical equation that approximates a line or curve 
of the specified order. It is the average error of all links. The formula for calculating RMS error is 
given below.  

 
The RMS error is the "average" error 
of all the links. 

As shown in the diagram below, you can think of the error associated with each control point as 
the distance between where you digitized the to-point and where the to-point actually ends up 
based on the best fit equation. The from-point is in fact the center of the grid cell, and no 
movement occurs until you issue the transformation function (warp). The greater the difference 
between the mathematically determined location and the user-defined to-point, the higher the 
RMS error. 



 
The error for a single link is the distance between the 
actual and calculated to-point locations. 

Factors contributing to RMS error include imprecise selection or digitizing of the From and To 
coordinates and an imperfect source of control coverage. Another possibility is that the links are 
accurate but the grid is severely deformed.  

The RMS error for each transformation is reported in the forward direction in map units of the To 
theme and in the backward direction in map units of From theme.  

A perfect transformation produces an RMS error of 0.00. Although you are unlikely to obtain a 
value of 0.00, you should try to keep your RMS error as low as possible. Acceptable values will 
vary depending on the accuracy of the original data and the scale of the source map. High RMS 
errors indicate that the to-points you designated and the transformed (calculated) to-points do not 
correspond to the same relative locations. In general, the higher the RMS error, the more poorly 
the output grid will register with the input coverage. The one caveat here is that if the input 
coverage contains irregular, geometric distortion, the RMS error will be high. 

Concept 
 
The Warp request 
 

The Avenue Warp request is used when a grid needs to be transformed from one map space to 
another. All cells are repositioned using a systematic transformation. A polynomial transformation 
is applied to a grid using links found in a list of links (lines). The idea is to fit a polynomial surface 
by least squares through the data points. The position of the actual output locations is dependent 
on the best-fit equation calculations.  

Avenue syntax:  

aGrid.Warp (aLinkList, anOrder, aGridResTypeEnum, aCellSize)  

aLinkList is a list of line objects. The starting point for each line defines the current x,y 
coordinates for that point on a grid, and the end point defines the desired coordinates for the 
point. These points are usually obvious geographic features, like street intersections or stream 
confluences.  

AnOrder specifies the order of polynomial transformation to apply. You should try to select the 
lowest order that produces an acceptable RMS error. The higher the anOrder argument, the more 
complex the distortion that can be corrected and the more the original data changes. However, it 
is usually not necessary to use anOrder higher than 3. The higher orders of polynomial will 



involve progressively more processing time. The best results are generally obtained with a first- 
or second-order polynomial with many links.  

The following diagram shows polynomial surfaces in three orders. 

 
Use the lowest possible order with Warp. 

aGridResTypeEnum defines the type of resampling to be used during the operation. Select from 
nearest neighbor, bilinear interpolation, or cubic convolution. Remember to check your data to 
find out if it is continuous or discrete and then select the appropriate resampling technique.  

aCellSize can be either a number or nil object--it defines the cell size for the output grid. If the cell 
size is set to nil, the output grid cell size will be the same as the input grid cell size.  

You can use the Avenue CalcPolynomialFit request to test the goodness of fit for a polynomial 
transformation performed with Warp.  

ArcView Spatial Analyst includes the Warp Environment sample extension to make it easier for 
you to georeference and warp grid datasets. You will use this sample extension in the exercise 
coming up. 

Concept 
 
Warp Environment extension 
 

The Warp Environment sample extension is a tool included with ArcView Spatial Analyst to help 
with the process of georeferencing and warping grid datasets. It places a menu, a button, and two 
tools on the view graphical user interface (GUI).  



The Warp menu has options of Set From View, Set To View, Set Link Table, Create Link Table, 
Type-in From Link, Type-in To Link, Calculate Fit, and Warp.  

• Set From View sets a view document where the ungeoreferenced grid dataset is 
displayed. This menu choice is enabled when a view document is available to be 
specified as the From View.  

• Set To View sets a view document where the georeferenced data is displayed. This 
menu choice is enabled when a view document is available to be specified as the To 
View.  

• Set Link Table sets a Link Table (a table containing coordinates of "from" links and "to" 
links) to be used in the warp calculation. This menu choice is enabled when a valid Link 
Table exists within the current project, which meets certain specifications (it must have 
the following 5 numeric fields present: Link, From_X, From_Y, To_X, and To_Y).  

• Create Link Table creates (and sets) an empty Link Table to be used in the warp 
calculation. The links are then created and logged into this table.  

• Type-in From Link allows the "from" link coordinates to be manually typed into the Link 
Table. This menu choice is enabled when the From View is active, a Link Table is set, 
and all links (if any) have both "from" link and "to" link coordinates.  

• Type-in To Link allows the "to" link coordinates to be manually typed into the Link Table. 
This menu choice is enabled when the To View is active, a Link Table is set, and a link in 
the Link Table is incomplete.  

• Calculate Fit allows the user to attain polynomial fit statistics on the active grid theme 
with the links found in the current link table without actually performing the warp of the 
grid.  

• Warp starts the warp calculation. Once started, the next dialog asks for the polynomial 
order number to be used (i.e., 1 - 12), and the next dialog asks for the type of resampling 
method (i.e., nearest neighbor, bilinear, or cubic convolution). The resultant warped grid 
dataset is added to the To View. This menu option is enabled when the From View is 
active, a grid theme is the active theme, a Link Table is set, and all links have both "from" 
link and "to" link coordinates.  

In addition to the menu options, a Delete Links button is included along with two tools, the From 
Link and To Link tools.  

• The Delete Links button deletes existing links by link number. This button is enabled 
when the Link Table is set, has one or more links, and all links have both "from" link and 
"to" link coordinates.  

• The From Link tool adds a "from" link (graphically) to the From View 
(ungeoreferenced data location). This tool is enabled when the From View is active, the 
Link Table is set, and all links (if any) have both "from" link and "to" link coordinates.  

• The To Link tool adds a "to" link (graphically) to the To View (georeferenced data 
location). This tool is enabled when the To View is active, the Link Table is set, and a link 
is incomplete.  

Procedurally, you should digitize many links ( a dozen or so) to establish a good average, then 
use Calculate Fit to test the goodness of fit for a given polynomial order. Examine the Total RMS 
error and Chi-Square values in the Fit Statistics message box and then click OK. Next, examine 
the output Coefficients Table and Errors Table. Use the Delete Link button to delete the links with 
the highest error. Then add more links to replace them. Repeat this until the average error is a 
small multiple of your cell size. For example, if your cell size is the equivalent of 30 meters, you 
should aim for an overall RMS of 60 or so.  

You'll learn how to use the Warp Environment extension in the next exercise. 



Concept 
 
Geometric transformation 
 

The transformation requests are used to correct common coordinate errors in grids derived from 
scanned images. These requests are not for georeferencing grids.  

These requests are:  

• Flip--flips a grid along its horizontal axis (Y direction).  

Avenue syntax:  

aGrid.Flip  

• Mirror--mirrors a grid along its vertical axis (X direction).  

Avenue syntax:  

aGrid.Mirror  

• Rotate--the grid rotates by any angle around the bottom-left corner.  

Avenue syntax:  

aGrid.Rotate (anAngle, aGridResTypeEnum)  

• Shift--shifts the bottom-left corner of a grid to a new x,y.  

Avenue syntax:  

aGrid.Shift (newOrigin, aCellSize) 

Exercise 
 
Georeference grids 
 
The objective of this exercise is to expose you to ArcView 
Spatial Analyst registration capabilities. You will use a grid 
theme that was originally a single band bil image developed from 
aerial photography. This dataset has no reference to any real-
world coordinate system because its source data is a 
photograph.  

In this exercise, you will register the grid to some street and 
building locations that already have a real-world coordinate 
system. 

  

   
If you have not downloaded 



the exercise data for this 
module, you should 
download the data now. 

     
 

Step 1  
 
Start ArcView 

  

Start ArcView and load the Spatial Analyst Extension.  

Note: If you are running ArcView GIS 3.1, you see a Welcome to ArcView GIS dialog. 
Click Cancel to close this dialog. 

If ArcView is already running, close any open projects. 

  

 
Step 2  

 
Open the project   

  

From the File menu, choose Open Project. Navigate to the dbaseSA\lesson1 
directory and open the project l1_ex03.apr. 

Note: If you are running ArcView GIS 3.1, you see an Update l1_ex03.apr message 
box. Click No to dismiss this box. 

When the project opens, you see several unopened views. 

  

 
Step 3  

 
Load the Warp Environment sample extension  

  

This exercise requires the Warp Environment sample extension. You'll load it now. 

To load the Warp Environment sample extension in ArcView, make the Project 
window active, then choose Extensions from the File menu.  

The Extensions dialog lists all the available extensions.  

Check the box next to Warp Environment (sample). 

If Warp Environment (sample) is not listed in the extensions dialog, you will need to 
copy the warp.avx file from ArcView's samples\ext directory to ArcView's ext32 
directory. These directories are located in ArcView's installation directory. A typical 
location (the default) for the installation directory is c:\esri\av_gis30\arcview. If you 
cannot find this path, try searching for the file arcview.exe to help you determine the 
correct path. 

Once you've done this, the sample extensions will be listed in the Extensions dialog 
the next time you open it. In that dialog, check the sample extension(s) you wish to 
load and press OK. 

If you don't want this sample extension to appear in the Extensions dialog 
permanently, you may load it temporarily by running a simple script. It will only be 
available for your current ArcView session. 

To run this sample script in ArcView perform the following steps: 

1. In ArcView's Project window, click the Scripts icon, then press New to create 

  



a new script.  
2. Type the following line into the script window:  

System.SetEnvVar( "USEREXT", 
"$AVHOME\samples\ext".AsFilename.GetFullname) 

3. Compile and run the script. 

Once you've done this, the sample extensions will be listed in the Extensions dialog 
the next time you open it. In that dialog, check the sample extension(s) you wish to 
load and press OK. 

 
Step 4  

 
Compare registered and unregistered themes  

  

Open the view called Maplewood Unregistered Grid.  

The view contains the Maplewood Grid theme, which currently has a grid origin of 
(0,0). You can see that it does not match with the Buildings and the Streets themes, 
which are already in a State Plane coordinate system. 

 

In the next steps, you will use the warp.avx sample extension to register the grid to 
the existing street and building themes. Because the two groups of themes are in 
different coordinate systems; therefore, you will display the grid theme in its own view 
and the street and building themes in a second view during the registration process. 

You will use tools in the Warp extension to identify common locations in each view. 
Common locations are street intersections that are visible in both the grid theme and 
the streets theme (or building corners that are visible in both themes). After creating a 
file of registration links, you will warp the grid theme. Warping georeferences the grid 
theme to the same coordinate system as the streets themes.  

Close the Maplewood Unregistered Grid view. 

 

  

 
Step 5  

 
Define From and To views  

  

Now you will designate the From and To views. The From view should contain the 
grid theme. Its coordinates will be changed to those of the To view. The To view 
should contain the Street and Building themes. 

Open the Maplewood Grid view.  

Notice a new Warp menu and the two extra tools, From Link and To Link tools 
.  

The registration process begins by defining a From and To view. First, you will define 
the Maplewood Grid view as the From view. 

From the Warp menu, choose Set From View. In the Set From View dialog, choose 
Maplewood Grid view. 

  



Click OK. 

Notice the name of the view is changed to Maplewood Grid (From View).  

Next, you'll define the To view.  

Open the Maplewood City Planning view. Keep the Maplewood Grid (From View) 
open.  

From the Warp menu, choose Set To View. In the Set To View dialog, choose 
Maplewood City Planning.  

Click OK.  

Notice that the name of the view is changed to Maplewood City Planning (To View). 

 
 

Step 6  
 
Create an empty link table   

  

Next, you will create an empty link table. The Link table stores the from and to 
coordinates of common locations that you select in each view.  

From the Warp menu, choose Create Link Table. Create the new table in your work 
directory and call it link1.dbf. The link table has no records, but contains five fields.  

 

The Link field stores unique identification numbers for the new links that you will 
create. The other four fields are x and y coordinate fields representing the coordinates 
you will enter in the From view and the To view. These links are used during the Warp 
process. 

 

  

 
Step 7  

 
Use the From tool  

  

Make the Maplewood Grid view active. Notice that the From tool is now available.  

Click the From tool , then click in the view on the street intersection in the upper 
right corner of the Maplewood Grid view as shown in the View Result below. 

 

Notice that after you added the first link at the street intersection, the Maplewood City 
Planning view opened automatically. The To tool is active and ready for you to add 
the corresponding To link. 

  

 
Step 8  

 
Use the To tool  

  
Use the To tool to click in the Maplewood City Planning view at the same 
intersection location in the upper right corner of the view as shown in View Result 
graphic below. 

  



 

Notice how a 1 is added to the To view at the corresponding intersection. 

You have now added one link and its ID number is 1. 
 

Step 9  
 
View the link table  

  

Open the Link1.dbf table.  

Notice that you have one record with a link of 1 and a pair of From and To x and y 
coordinates. Your coordinates may be slightly different than those shown in the View 
Result graphic for this step. 

 

  

 
Step 10  

 
Create additional From and To links  

  

On your own, add five more From and To links in the corresponding views (you can 
add even more links if you want).  

The Warp Environment extension also gives you a Delete button on the view 
interface to delete links that you think are bad. 

  

 
Step 11  

 
Test the links' fit  

  

Before running warp, you should perform a test on the link table to see how well the 
input and output links fit the mathematical equation for the selected order. The 
Calculate Fit option in the Warp menu is used to perform this test.  

Note that Calculate Fit does not really perform a permanent coordinate 
transformation. Rather, it tells you how much error you can expect in the output if you 
use the given set of control points.  

From the Warp menu, choose Calculate Fit.You will be asked to enter an order. Enter 
1 and choose OK. 

Calculate Fit then computes total RMS (root mean square) error and the RMS error 
for each link.  

The first thing you will see is a Fit Statistics box reporting total RMS error in the X and 
Y direction. Ideally, you want these values to be a small multiple of the cell size of the 
unregistered grid. In this case, the resolution of the Maplewood Grid slightly over 2 so 
RMS values in the range of 6 or less might be considered acceptable for the purposes 
of this exercise. 

 

Click OK after viewing the RMS error information. 

Next, examine the Errors Table produced by Calculate Fit. This table shows you the 
individual X-error and Y-error for each link. Make a note of any Link-id values that you 

  



think have unacceptable RMS errors.  

Use the Delete Links button to delete any links you think are bad. Then you can 
add additional links to replace them using the From Link and To Link tools. Use 
Calculate Fit after deleting and adding links until you are satisfied with the RMS error. 

 
 

Step 12  
 
Use Warp  

  

Next, you will warp the grid theme using the registration links in the link table. 

After creating at least six well-distributed links, make the Maplewood Grid view active. 
From the Warp menu, choose Warp. When prompted, use a 1st order warp.  

Choose the nearest neighbor resampling method. 

Be patient while the grid theme is being warped using your links. The input grid theme 
is not edited; however, a new warped grid theme is created and added to the To view. 

Make the Maplewood City Planning (To View) active. 

Turn on the new Warp of Maplewood Grid theme and move it to the bottom of the 
Table of Contents. If you want, set a different color scheme using the Legend Editor. 

 

Did it warp correctly? If not, you may have to go through the process of defining 
another link table, building the registration links, and warping again. 

 

  

 
Step 13  

 
Close the project  

  Close the project without saving any changes. You have completed this exercise.  
 
Summary 
 

In this lesson, you learned that grid-based coincidence analysis is a comparison of overlaying 
cells and is very fast. The resolution of grid-based data is determined by cell size. Resolution and 
accuracy increase as cell size decreases. 

Grid themes are always assumed to be in a projection and feature themes are projected on the fly 
to match the projection of the grid theme. Projections are set in the View Properties dialog and 
are set to the same projection as the grid themes. 

Grids should be registered to real-world coordinates. Themes must be in the same coordinate 
space for analysis. Georeferencing is the process of matching the location of a non-registered 
grid to real-world coordinates. Non-georeferenced grids contain cells that do not match real-world 
locations. 



The Warp request transforms a grid from one map space to another using link lines. Link lines are 
created by assigning from and to links between the non-georeferenced grid and the theme 
containing real-world coordinates. 

Geometric transformation is primarily used for scanned images. ArcView Spatial Analyst includes 
requests (Flip, Mirror, Rotate, and Shift) to correct common coordinate errors in grids derived 
from scanned images. 

This is the Grid Database Issues in ArcView Spatial Analyst - Lesson 1 Self test. 
 Please watch your time—you have 2 hours to complete this test.  

Use the knowledge you have gained in Grid Database Issues in ArcView Spatial Analyst to 
answer the following questions. You will need to correctly answer 7 of the following questions to 
pass.  

Netscape Users: Do not resize this browser window. This can cause the page to reload 
and generate new questions.  

GOOD LUCK!  

 
1.  Using a smaller cell size guarantees better accuracy. 

True 

False 

2.  Grid cells must line up between layers and share the same cell size in order to perform 
analysis. 

True 

False 

3.  Georeferencing is the process of matching the location of a non-registered grid to real-world 
locations. 

True 

False 

4.  A grid may be transformed from one map space to another using the: 

Avenue LinkLine request 

Avenue Warp request or the Warp Environment Extension 

Avenue Transform request 

CellTools sample extension 

5.  The higher the order of a polynomial used, the less complex the distortion that can be 
corrected. 

True 



False 

6.  Grids derived from scanned images will often have an origin of: 

0,0 

1,1 

999,999 

-1,-1 

7.  Grid-based coincidence analysis is made possible only when: 

Grids are floating point 

Grids are in geographic coordinates 

Grids share the same resolution 

Grids are registered to one another or to a common coordinate system 

8.  What happens when generalization of a grid increases? 

Error decreases and precision decreases 

Error increases and precision decreases 

Error decreases and precision increases 

Error increases and precision increases 

9.  The Rotate request rotates a grid by any angle around the center of the grid. 

True 

False 

10.  What is the minimum number of links required for a fourth-order polynomial when using 
Warp? 

3 

6 

10 

15 
 

 

Calculate My Grade
 

 


